
5 PRINTING

This chapter explains how to print your documents in 
Windows and how to use the print settings. 

This chapter includes:

• Printing a Document

• Setting Paper Properties

• Printing Multiple Pages on One Sheet of Paper 
(N-Up Printing)

• Printing a Reduced or Enlarged Document

• Fitting Your Document to a Selected Paper Size

• Printing Posters

• Using Watermarks

• Using Overlays

• Setting Graphic Properties

• Setting Up the Locally Shared Printer
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Printing a Document

The following procedure describes the general steps required for 
printing from various Windows applications. The exact steps for 
printing a document may vary depending on the application 
program you are using. Refer to your software application’s 
User’s Guide for the exact printing procedure.

NOTE: For detailed information about printing from a Macintosh 
computer, see Appendix A. 

1 Open the document you want to print.

2 Select Print from the File menu. 

The Print window is displayed. It may look slightly different 
depending on your application. 

The basic print settings are selected within the Print 
window. These settings include the number of copies and 
print range.

3 To take advantage of the printer features provided by your 
machine, click Properties in the application’s print window 
and go to Step 4. 

If you see Setup, Printer or Options, click that button 
instead. Then click Properties in the next screen.

Make sure that your 
machine is selected.

��Windows 98
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4 Now you see the Samsung SCX-4x16 Series Properties 
window, which allows you to access all of information you 
will need when using your machine. 

The Layout tab is first displayed.   

If necessary, select the Orientation option. 

The Orientation option allows you to select the direction in 
which information is printed on a page. 

• Portrait prints across the width of the page, letter style. 

• Landscape prints across the length of the page, 
spreadsheet style. 

• If you want to rotate the page in 180 degrees, select Rotate 
180 Degrees.

5 From the Paper tab, select the paper source, size and type. 
For further details, see page 5.7. 

The preview image 
shows the sample page 
with the settings you 
currently specified.

��Landscape ��Portrait
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6 If necessary, you can set in what sequence the pages will be 
printed from the Extra tab. Select the required print order 
from the Print Order drop-down list.

• Normal: Your machine prints in normal order.

• Reverse All Pages: Your machine prints all pages in 
reversed order. This setting is helpful when you are using 
the rear output slot.

• Print Odd Pages: Your machine prints only the odd 
pages of the document.

• Print Even Pages: Your machine prints only the even 
pages of the document.

7 Click other tabs on the top of the Samsung SCX-4x16 Series 
Properties window to access other features, if needed. 

8 When you finish setting the properties, click OK until the 
Print window is displayed. 

9 Click OK to start printing. 

Notes:

• Most Windows applications will override settings you specified in 
the printer driver. Change all of the print settings available in the 
software application first, and change any remaining settings 
using the printer driver. 

• The settings you change remain in effect only while you are 
using the current program. To make your changes permanent, 
make them in the Printers folder. Follow these steps:

1. Click the Windows Start menu.

2. For Windows 95/98/Me/NT 4.0/2000, select Settings and 
then Printers.

For Windows XP, select Printers and Faxes.

3. Select the Samsung SCX-4x16 Series printer.

4. Click the right mouse button on the printer icon and: 

• For Window 95/98/Me, select Properties.
• For Windows 2000/XP, select Print Setup or select 

Properties and click Printing Preferences.
• For Windows NT 4.0, select Document Default.

5. Change the settings on each tab and click OK.



PRINTING 5.5

5

Canceling a Print Job

There are two ways to cancel a print job:

To stop a print job from the control panel:

Press the Stop/Clear button. 

Your machine will finish printing the 
page that is moving through the 
machine and delete the rest of the 
print job. Pressing the button cancels 
only the current job. If more than one 
print job is in the machine’s memory, 
you need to press the button once for 
each job.

To stop a print job from the Printers folder:

1 From the Windows Start menu, select Settings.

2 Select Printers to open the Printers window and 
double-click the Samsung SCX-4x16 Series icon. 

3 From the Document menu, select Cancel Printing 
(Windows 9x/Me) or Cancel (Windows NT 4.0/2000/XP).

NOTE: You can access this window simply by double-clicking the 
printer icon at the bottom right corner of the Windows desktop.

��Windows 98
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Using a Favorite Setting

The Favorites option, which is visible on each properties tab, 
allows you to save the current properties settings for future use. 

To save a Favorites item:

1 Change the settings on each tab, as needed. 

2 Enter a name for the item in the Favorites input box. 

3 Click Save. 

To use a saved setting, select it from the Favorites drop-down 
list. 

To delete a favorite setting item, select it from the list and click 
Delete. 

You can also restore the printer driver’s default settings by 
selecting <Printer Default> from the list. 

Using Help

Your machine has a help screen that can be activated by the 
Help button in the printer’s properties window. These help 
screens give detailed information about the printer features 
provided by the printer driver.

You can also click  from the upper right hand corner, and then 
click on any setting. 
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Setting Paper Properties

Use the following options to set the paper handling needs when 
you access the printer properties. See page 5.2 for more 
information about accessing printer properties. 

Click the Paper tab to access many paper properties. 

Property Description

Copies Copies allows you to choose the number of 
copies to be printed. You can enter up to 999. 

 Size The Size option allows you to choose the size 
of paper loaded in the tray. 

If the required size is not listed in the Size 
box, click Add Custom. When the Custom 
Page Size window appears, set the paper size 
and click Ok. The size setting appears in the 
Size list so that you can select it. 

1

2

3

4

1

2

Enter the custom 
name you want to
use. 

Enter the paper 
size. 



PRINTING5.8

Printing Multiple Pages on One 
Sheet of Paper (N-Up Printing)

You can select the number of pages to print on a single sheet of 
paper. To print more than one page per sheet, the pages will 
appear decreased in size and arranged on the sheet. You can 
print up to 16 pages on one sheet.

1 To change the print settings from your software application, 
access the printer properties. See page 5.2.

2 From the Layout tab, choose Multiple Pages per Side in 
the Type drop-down list. 

Source Make sure that Source is set to the 
corresponding paper tray.

The Manual Feed source is used when 
printing to special materials. You need to load 
one sheet at a time into the Bypass Tray. See 
page 3.8.

If the paper source is set to Auto Select, 
the machine automatically picks up print 
materials according to the following order: 
the Bypass tray and the paper tray.

Type Make sure that Type is set to Printer 
Default. If you load a different type of print 
material, select the corresponding paper 
type. For more information on print 
materials, refer to Chapter 3, "Paper 
Handling." 

Property Description

3

4

1 2

3 4



PRINTING 5.9

5

3 Select the number of pages you want to print per sheet 
(1, 2, 4, 9 or 16) in the Pages per Side drop-down list.

4 Select the page order in the Page Order drop-down list, if 
necessary.

Check Print Page Border to print a border around each 
page on the sheet. Print Page Border is enabled only, if 
the pages per sheet is 2, 4, 9 or 16.

5 Click the Paper tab and select the paper source, size and 
type.

6 Click OK and print the document. 

Right, Then 
Down

1

3

2

4

1

2

3

4

2

4

1

3

3

4

1

2
Down, Then 
Right

Left, Then 
Down

Down, Then 
Left
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Printing a Reduced or Enlarged 
Document

You can scale your print job on a page. 

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2. 

2 From the Layout tab, select Reduce/Enlarge in the Type 
drop-down list. 

3 Enter the desired scaling rate in the Persentage input box. 

You can also click the ��or � button.

4 Click the Paper tab and select the paper source, size and 
type. 

5 Click OK and print the document. 
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Fitting Your Document to a Selected 
Paper Size

You can scale your print job to any selected paper size 
regardless of the digital document size. This can be useful when 
you want to check fine details on a small document. 

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2.

2 From the Layout tab, select Fit to Page in the Type 
drop-down list. 

3 Select the correct size from the Target Paper drop-down 
list.

4 Click the Paper tab and select the paper source, size and 
type.

5 Click OK and print the document. 

A
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Printing Posters

You can print a single-page document onto 4, 9 or 16 sheets of 
paper, for the purpose of pasting the sheets together to form 
one poster-size document.

1 When you change the print settings from your software 
application, access the printer properties. See page 
page 5.2.

2 From the Layout tab, select Poster in the Type drop-down 
list. 

3 Configure the poster option:

You can select the page layout from 2x2, 3x3 or 4x4. If you 
select 2x2, the output will be automatically stretched to 
cover 4 physical pages. 

��2 x 2 ��3 x 3



PRINTING 5.13

5

Specify an overlap in millimeters or inches to make it easier 
to reconstruct the resulting poster. 

4 Click the Paper tab and select the paper source, size and 
type.

5 Click OK and print the document. You can complete the 
poster by reconstructing the results. 

Using Watermarks

The Watermark option allows you to print text over an existing 
document. For example, you may want to have large gray letters 
reading “DRAFT” or “CONFIDENTIAL” printed diagonally across 
the first page or all pages of a document. 

There are several predefined watermarks that come with your 
machine, and they can be modified or you can add new ones to 
the list. 

Using an Existing Watermark

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2. 

2 Click the Extras tab and select a watermark in the 
Watermark drop-down list. You will see the selected 
watermark in the preview image. 

0.1 inches

0.1 inches

Preview 
image



PRINTING5.14

3 Click Ok and start printing. 

Creating a Watermark

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2. 

2 Click the Extras tab and click the Edit button in the 
Watermark section. The Edit Watermarks window appears. 

3 Enter the text message you want to print in the 
Watermark Message box. 

The message will be displayed in the preview window. The 
preview image is provided so that you can see how the 
watermark will appear on the printed page.

If the First Page Only box is checked, the watermark will 
be printed on the first page only.

4 Select the desired watermark options. 

You can select the font name, style and size and grayscale 
level from the Font Attributes section and set the angle of 
the watermark from the Message Angle section. 

5 Click Add to add a new watermark to the list. 

6 When you finish creating, click Ok and start printing. 

To stop printing the watermark, select <No Watermark> in the 
Watermark drop-down list. 
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Editing a Watermark

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2. 

2 Click the Extras tab and click the Edit button in the 
Watermark section. The Edit Watermarks window appears.

3 Select the watermark you want to edit in the Current 
Watermarks list, and change the watermark message and 
the options. Refer to “Creating a Watermark” on page 5.14. 

4 Click Update to save the changes.

5 Click Ok. 

Deleting a Watermark

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2.

2 From the Extras tab, click the Edit button in the 
Watermark section. The Edit Watermarks window appears.

3 Select the watermark you want to delete in the Current 
Watermarks list and click Delete. 

4 Click Ok.
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Using Overlays

What is an Overlay?

An overlay is text and/or images stored in the computer hard 
disk drive (HDD) as a special file format that can be printed on 
any document. Overlays are often used to take the place of 
preprinted forms and letterhead paper. Rather than using 
preprinted letterhead, you can create an overlay containing the 
exact same information that is currently on your letterhead. To 
print a letter with your company’s letterhead, you do not need 
to load preprinted letterhead paper in the machine. You need 
only tell the machine to print the letterhead overlay on your 
document.

Creating a New Page Overlay

To use a page overlay, you must create a new page overlay 
containing your logo or image.

1 Create or open a document containing text or an image for 
use in a new page overlay. Position the items exactly as you 
wish them to appear when printed as an overlay. If needed, 
save the file for later use.

2 When you change the print settings from your software 
application, access the printer properties. See page 5.2.

3 Click the Extras tab and click Edit button in the Overlay 
section. 

WORLD BEST

Dear ABC

Regards

WORLD BEST
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4 In the Edit Overlays window, click Create Overlay. 

5 In the Create Overlay window, type a name of up to eight 
characters in the File name box. Select the destination 
path, if necessary. (The default is C:\Formover).

6 Click Save. You can see the name in Overlay List. 

7 Click OK or Yes until you complete creating. 

The file is not printed out. Instead it will be stored on your 
computer HDD disk. 

NOTE: The overlay document size must be the same as 
documents you will print with the overlay. Do not create an overlay 
with a watermark. 
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Using a Page Overlay

After an overlay has been created, it is ready to be printed with 
your document. To print an overlay with a document:

1 Create or open the document you want to print. 

2 When you change the print settings from your software 
application, access the printer properties. See page 5.2. 

3 Click the Extras tab. 

4 Select the overlay you want to print from the Overlay 
drop-down list box. 

5 If the desired overlay file does not appear in the Overlay 
list, click the Edit button and Load Overlay, and select the 
overlay file. 

If you have stored the overlay file you want to use into an 
external source, you can also load the file when you access 
this Load Overlay window. 

After you select the file, click Open. The file is now shown 
in the Overlay List box and is available for printing. Select 
the overlay from the Overlay List box. 
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6 If necessary, click Confirm Page Overlay When Printing. 
If this box is checked, a message window will appear each 
time you submit a document for printing, asking you to 
confirm your wish to print an overlay on your document. 

Answering Yes to the window means that the selected 
overlay will be printed with your document. Answering No 
to the window cancels overlay printing. 

If this box is empty and an overlay has been selected, the 
overlay will be automatically printed with your document. 

7 Click OK or Yes until the printing starts. 

The selected overlay will be downloaded with your print job 
and printed on your document. 

Note: The resolution of the overlay document must be the same 
as that of the document you will print with the overlay.  

Deleting a Page Overlay

You can delete page overlays that are no longer used. 

1 In the printer properties window, click the Extras tab. 

2 Click Edit in the Overlay section. 

3 Select the overlay you want to delete from the Overlay 
List box. 

4 Click Delete Overlay. 

5 Click OK until you exit the Print window.
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Setting Graphic Properties

Use the following graphic options to adjust the print quality for 
your specific printing needs. See page 5.2 for more information 
about accessing printer properties.

Click the Graphics tab to display the properties shown below. 

Property Description

Resolution

You can select the printing resolution by 
choosing from 600 dpi (Normal) or 
300 dpi (Draft). The higher the setting, 
the sharper the clarity of printed 
characters and graphics. Higher settings 
may increase time it takes to print a 
document.

Toner Save

Selecting this option will extend the life of 
your toner cartridge and reduce your cost 
per page without a significant reduction in 
the print quality. 
• Printer Setting: If you select this 

option, the Toner Save feature is 
determined by the setting you’ve made on 
the control panel of the printer.

• On: Select this option to allow the printer 
to use less toner on each page.

• Off: If you do not need to save toner to 
print a document, select this option.

1

3

2

1

2
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Advanced 
Options 

You can set advanced settings by clicking 
the Advanced Options button. 

Property Description

3

Darkness
Use this option to lighten or darken the 
image appearance in your print.
• Normal: This setting is for normal 

documents.
• Light: This setting is for bolder line 

widths or darker gray-scale images.
• Dark: This setting is for finer line width, 

higher definition in graphics and lighter 
gray-scale images.

When the Darken Text option is checked, 
all text in your document is allowed to print 
darker than a normal document. 

Print All Text Black
When the Print All Text Black option is 
checked, all text in your document is allowed 
to print solid black, regardless of the color it 
appears on the screen. When it is not 
checked, colored text is allowed to print in 
shades of gray.
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Setting Up the Locally Shared Printer

You can connect the machine directly to a selected computer, 
which is called “host computer,” on the network. Your machine 
can be shared by other users on the network through a Windows 
9x, Me, 2000, XP or NT 4.0 network printer connection. 

In Windows 9x/Me

Setting Up the Host Computer

1 Start Windows.

2 From the Start menu, select Control Panel and 
double-click on the Network icon. 

3 Check the File and Print Sharing box and click OK. 

Advanced 
Options 
(continued)

Property Description

3
True Type Options
This option determines what the driver tells 
the machine about how to image the text in 
your document. Select the appropriate 
setting according to the status of your 
document. 

• Download as Bit Image: When this 
option is selected, the driver will download 
the font data as bitmap images. 
Documents with complicated fonts, such as 
Korean or Chinese, or various types of 
fonts will print faster in this setting. 

• Print as Graphics: When this option is 
selected, the driver will download any fonts 
as graphics. When printing documents with 
high graphic content and relatively few 
TrueType fonts, printing performance 
(speed) may be enhanced in this setting.
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4 Click Start and select Printers from Settings. Double-click 
your printer name. 

5 Select Properties in the Printer menu. 

6 Click the Sharing tab and check the Shared As box. Fill in 
the Shared Name field and then click OK. 

Setting Up the Client Computer

1 Right-click Start and select Explorer. 

2 Open your network folder in the left column. 

3 Right-click the shared name and select Capture Printer 
Port. 

4 Select the port you want, check the Reconnect at log on 
box and then click OK.

5 From the Start menu, select Settings and then Printers. 

6 Double-click your printer icon. 

7 From the Printer menu, select Properties. 

8 From the Details tab, select the printer port and click OK.

 

In Windows NT 4.0/2000/XP

Setting Up the Host Computer

1 Start Windows. 

2 For Windows NT 4.0/2000, from the Start menu, select 
Settings and then Printers. 

For Windows XP, from the Start menu, select Printers and 
Faxes. 

3 Double-click your printer icon. 

4 From the Printer menu, select Sharing. 
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5 For Windows NT 4.0, check the Shared box. 

For Windows 2000, check the Shared As box.

For Windows XP, check the Share this printer box. 

6 For Windows NT 4.0, fill in the Share Name field and click 
OK. 

For Windows 2000/XP, fill in the Shared Name field and 
click OK. 

Setting Up the Client Computer

1 Right-click Start and select Explorer. 

2 Open your network folder in the left column. 

3 Click the shared name. 

4 For Windows NT 4.0/2000, from the Start menu, select 
Settings and Printers. 

For Windows XP, from the Start menu, select Printers and 
Faxes.

5 Double-click your printer icon. 

6 From the Printer menu, select Properties. 

7 Press the Ports tab and click Add Port. 

8 Select Local Port and click New Port. 

9 Fill in the Enter a port name field and enter the shared 
name. 

10Click OK and click Close. 

11 For Windows NT 4.0, click OK.

For Windows 2000/XP, click Apply and click OK.



6 SCANNING

Scanning with your machine lets you turn pictures and text 
into digital files on your computer. Then you can fax or 
e-mail the files, display them on your web site or use them 
to create projects that you can print using Samsung 
SmarThru software.

This chapter includes:

• Scanning Basics

• Scanning Using the Samsung SmarThru

• Scanning Process with TWAIN-enabled Software
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Scanning Basics

Your machine offers two ways to begin scanning:

• From the Samsung SmarThru software: Launch Samsung 
SmarThru and open the Scan Wizard to begin scanning. See 
below.

• From TWAIN-compliant software: You can use other software 
including Adobe PhotoDeluxe and Adobe Photoshop. See 
page 6.5.

NOTES:

• To scan with your machine, you must install the MFP driver. 

• Scanning is done through the same LPT or USB port currently 
assigned for your printer port. 

Scanning Using the Samsung 
SmarThru

Samsung SmarThru is the accompanying software for your 
machine. With the SmarThru, scanning becomes a pleasure.

Follow these steps to start scanning using the SmarThru:

1 Make sure that your machine and computer are turned on 
and properly connected to each other. 

2 Place a single document face down on the document glass 
then close the cover. For further details, see page 4.2.

OR

Load the document(s) to be scanned face up into the ADF 
(Automatic Document Feeder). For further details, see 
page 4.4.
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3 Once you have installed Samsung software, you see the 
SmarThru icon on the desktop window. Double-click the 
SmarThru 3 icon.

The SmarThru 3 window opens.

4 To open the Scan Wizard, click the Scan Wizard icon in the 
plugin bar on the left of the SmarThru 3 window.

Double-click this icon.

Scan Wizard
icon.



SCANNING6.4

The Scan Wizard lets you use the following services:

• Scan
Lets you scan the original documents and save them in 
the Image Manager of the Samsung SmarThru system. 
The Image Manager is an image database manager and 
image editor program. 

• Copy
Lets you use your machine to produce professional quality 
copies. You can adjust the image size and select advanced 
settings.

•Scan to Email
Lets you scan the original documents and then launches a 
default mail program of your system, such as Microsoft 
Outlook Express, so that you can send the scanned image 
attached to a new mail. To send e-mail using the Samsung 
SmarThru system, you need to enable the Internet Gate 
and configure an e-mail account in SmarThru 
Configuration. Refer to the SmarThru User’s Guide.

• Scan to FAX
Lets you scan the original documents and then launches a 
New Fax form which helps you to send them as a fax 
image. This service is available only when you enable and 
configure the Fax Gate in SmarThru Configuration. Refer 
to the SmarThru User’s Guide.

• Scan to WEB
Lets you scan the original documents for further 
publishing to the Web.

• Scan to OCR
Lets you scan the original documents and pass them to 
the OCR program. OCR (Optical Character Recognition) is 
the process of converting a scanned image into text that 
you can edit in a word processing program. After you scan 
your document, the software processes or “recognizes” it. 
Then you can change it and either save the file or open it 
in any word processing program on your computer.

5 Click the desired service icon.
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6 The Samsung Scan Manager opens for the selected service. 
Adjust the scan settings. You can use the Help button to 
receive on-line help. 

7 To start scanning, click Scan. 

For more information, please refer to the SmarThru User’s 
Guide which came with your machine.

NOTE: If you want to cancel the scan job, press the Stop/Clear 
button on the control panel.

Scanning Process with TWAIN-
enabled Software 

If you want to scan documents using other software, you will 
need to use TWAIN-compliant software, such as Adobe 
PhotoDeluxe or Adobe Photoshop. The first time you scan with 
your machine, select it as your TWAIN source in the application 
you use. 

The basic scanning process involves a number of steps:
• Place your photograph or page on the document glass.
• Open an application, such as PhotoDeluxe or Photoshop. 
• Open the TWAIN window and set the scan options.
• Scan and save your scanned image.

You need to follow the program’s instructions for acquiring an 
image. Please refer to the application’s User’s Guide.
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MEMO



7 MAINTENANCE

This chapter provides information for maintaining the toner 
cartridge and your machine.

This chapter includes:

• Clearing the Memory

• Cleaning Your Machine

• Maintaining the Toner Cartridge

• Consumables and Replacement Parts
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Clearing the Memory

You can selectively clear information stored in your machine’s 
memory.

1 Press Menu on the control panel until “Maintenance” 
appears on the top line of the display. 

2 Press the scroll button (� or �) until you see “Clear 
Memory” on the bottom line and press Enter.

The first available menu item, “Paper Setting,” displays on 
the bottom line.

3 Press the scroll button (� or �) until you see the item you 
want to clear.

• Paper Setting: Restores all of the Paper Setting options to 
the factory default.

• Copy Setup: Restores all of the Copy Setup options to the 
factory default.

• Fax Setup: (only for SCX-4216F) Restores all of the Fax 
Setup options to the factory default.

• Fax Feature: (only for SCX-4216F) Cancels all of the 
scheduled fax jobs in the machine’s memory.

• Advanced Fax: (only for SCX-4216F) Restores all of the 
Advanced Fax setting options to the factory default.

• Sent Report: (only for SCX-4216F) Clears all of records of 
your faxes sent. 

• RCV Report: (only for SCX-4216F) Clears all of records of 
your faxes received.

• Phone Book: (only for SCX-4216F) Clears the speed dial 
or group dial numbers stored in the memory.

4 Press Enter. The selected memory is cleared and the 
display asks you to continue clearing the next item.

5 Repeat steps 2 and 3 to clear another item. 

OR

To return to the standby mode, press Stop/Clear. 
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Cleaning Your Machine

To maintain the print quality, follow the cleaning procedures 
below each time the toner cartridge is replaced or if print quality 
problems occur.

CAUTIONS: 

• Do not pour or spray water directly onto any part of your 
machine.

• Do not use ammonia-based cleaners or volatile solvents, such as 
thinner, on or around the machine. These can damage the 
machine.

• While cleaning the inside of the machine, be careful not to touch 
the transfer roller, which is located underneath the toner 
cartridge. Oil from your fingers can cause print quality problems.

Cleaning the Outside

Wipe the outside surface of the machine with a soft, clean and 
lint-free cloth. You can dampen the cloth slightly with water, but 
be careful not to be let any water drip onto the machine or the 
inside of it.

Cleaning the Inside

During the printing process, paper, toner and dust particles can 
accumulate inside the machine. This buildup can cause print 
quality problems, such as toner specks or smearing. Cleaning 
the inside of the machine will clear or reduce these problems.

1 Turn the machine off and unplug the power cord. Wait for 
the machine to cool down.

2 Open the front cover and pull the toner cartridge out, lightly 
pushing it down.
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3 With a dry and lint-free cloth, wipe away any dust and 
spilled toner from the toner cartridge area and the toner 
cartridge cavity.

CAUTION: To prevent damage to the toner cartridge, do not 
expose it to light for more than a few minute. Cover it with a piece 
of paper, if necessary. Do not touch the black transfer roller inside 
the machine. 

4 Reinsert the toner cartridge and close the cover.

5 Plug in the power cord and turn the machine on.

Cleaning the Scan Unit

Keeping the scan unit clean helps ensure the best possible 
copies. We suggest that you clean the scan unit at the start of 
each day and during the day, as needed.

1 Slightly dampen a soft lint-free cloth or paper towel with 
water.

2 Open the document cover.
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3 Wipe the surface of the document glass and ADF glass 
(for SCX-4116/4216F) until it is clean and dry.

4 Wipe the underside of the white document cover and white 
sheet (for SCX-4116/4216F) until it is clean and dry.

5 Close the document cover.

Maintaining the Toner Cartridge

Toner cartridge storage

To get the most from the toner cartridge, keep the following 
guidelines in mind:

• Do not remove the toner cartridge from its package until 
ready for use. 

• Do not refill the toner cartridge. The machine warranty 
does not cover damage caused by using a refilled 
cartridge.

• Store toner cartridges in the same environment as your 
machine.

• To prevent damage to the toner cartridge, do not expose it to 
light for more than a few minute.

Document 
cover

Document glass

White sheet

ADF glass
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Saving toner

To save toner, press the Toner Save button on the printer 
control panel; see page 1.19. The button backlight will be lit. 
Using this feature will extend the life of the toner cartridge and 
reduce your cost per page, but it will reduce the print quality. 

Expected Cartridge Life

The life of the toner cartridge depends on the amount of toner 
that print jobs require. When printing text at IDC 5% coverage, 
a new toner cartridge lasts an average of 3,000 pages. (The 
original toner cartridge supplied with the printer lasts an 
average of 1,000 pages.) The actual number may be different 
depending on the print density of the page you print. If you print 
a lot of graphics, you may need to change the cartridge more 
often.

Redistributing Toner

When the toner cartridge is near the end of its life, white streaks 
or light print will occur. The LCD displays the warning message 
“Toner Low.” You can temporarily reestablish the print quality by 
redistributing the remaining toner in the cartridge.

1  Open the front cover.

2 Pull the toner cartridge out and gently shake the cartridge 
to distribute the toner evenly inside the cartridge.
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NOTE: If the toner gets on your clothing, wipe it off with a dry 
cloth and wash clothing in cold water. Hot water sets the toner into 
fabric.

3 Reinstall the cartridge and close the front cover.

Replacing the Toner Cartridge

If the toner eventually runs out, only blank pages will print when 
a print job is sent or when a fax is received. At this stage, the 
toner cartridge needs to be replaced. The display shows the 
warning message, “Toner Empty” and the  indicator on the 
control panel turns on.

1 Open the front cover.

2 Lightly pushing the used cartridge down, pull it out.
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NOTE: Help the environment by recycling your used toner 
cartridge. Refer to the recycling brochure packed with the toner 
cartridge for details.

3 Unpack the new toner cartridge and gently shake it 
horizontally four or five times to distribute the toner evenly 
inside the cartridge.

Save the box and the cover for shipping.

4 Slide the new toner cartridge in until it locks into place.

5 Close the front cover.
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Setting the Notify Toner Option 
(For SCX-4216F)

If you have set the Notify Toner menu option to “On”, your 
machine automatically sends a fax to your service company or 
the dealer to notify them that your machine requires a new 
toner cartridge when the toner cartridge needs to be replaced. 
The fax number is preset by your dealer when you bought your 
machine.

1 Press Menu on the control panel until “Maintenance” 
appears on the top line of the display. The first available 
menu item, “Clean Drum,” displays on the bottom line.

2 Press the scroll button (� or �) to display “Notify Toner” on 
the bottom line and press Enter. 

3 Press the scroll button (� or �) to change the setting. 

Select “On” to enable this feature. Selecting “Off” disables 
this feature.

4 Press Enter to save the selection.

Cleaning the Drum

If there are streaks or spots on your print, the OPC drum of the 
cartridge may require cleaning.

1 Before setting the cleaning procedure, make sure that 
paper is loaded in the machine. 

2 Press Menu on the control panel until “Maintenance” 
appears on the top line of the display. The first available 
menu item, “Clean Drum,” displays on the bottom line.

3 Press Enter.

The display confirms your selection.

4 Press Enter to accept “Yes.”

The machine prints out a cleaning page. Toner particles on 
the drum surface are affixed to the paper. 

5 If the problem remains, repeat steps 1 through 4.
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Consumables and Replacement 
Parts

From time to time, you will need to replace the toner cartridge, 
roller, and fuser unit to maintain top performance and to avoid 
print quality problems and paper feed problems resulting from 
worn parts.

The following items should be replaced after you have printed a 
specified number of pages. See the table below.

To purchase the consumables and replacement parts, contact 
your Samsung dealer or the retailer where you bought your 
machine. We strongly recommend that items be installed by a 
trained service professional, except for the toner cartridge.

Items Yield (Average)

ADF rubber pad 20,000

ADF roller 60,000

Paper feeding roller 60,000

Transfer roller 60,000

Fuser unit 60,000
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8 TROUBLESHOOTING

This chapter gives helpful information for what to do if you 
encounter an error.

This chapter includes:

• Clearing Document Jams (For SCX-4116/4216F)

• Clearing Paper Jams

• Clearing LCD Error Messages

• Solving Problems
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Clearing Document Jams (For SCX-4116/4216F)

If a document jams while it is feeding through the ADF 
(Automatic Document Feeder), “Document Jam” appears on the 
display.

Input Misfeed

1 Remove the remaining documents from the ADF.

2 Open the ADF top cover.

3 Push the bushing on one end of the ADF roller inward ( ) 
and rotate it to the left ( ). Then remove the roller from 
the slot and pull the document gently to the right and out of 
the ADF.

4 Close the ADF top cover. Then load the documents back into 
the ADF.

NOTE: To prevent document jams, use the document glass for 
thick, thin or mixed documents. 

a
b
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Exit Misfeed

1 Remove the remaining documents from the ADF.

2 Open the document cover and turn the release knob to 
remove the misfed documents from the document output 
tray.

3 Close the document cover. Then load the documents back 
into the ADF.

Roller Misfeed

1 Remove the remaining documents from the ADF.

2 Open the document cover.

3 Turn the release knob so that you can easily seize the 
misfed document, and remove the document from the roller 
or the feed area by carefully pulling it to the right by using 
both hands.

4 Close the document cover. Then load the documents back 
into the ADF.
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Clearing Paper Jams

If paper jams occur, “Paper Jam” appears on the display. Refer 
to the table below to locate and clear the paper jam.

To avoid tearing the paper, pull the jammed paper out gently 
and slowly. Follow the steps below to clear a jam. 

In the Paper Feed Area

1 Open and close the front cover. The jammed paper 
automatically exits the machine.

If the paper does not exit, continue to Step 2.

2 Pull the paper tray open. 

Message Location of Jam Go to

Paper Jam 0 In the paper feed area below

Paper Jam 1 In the paper exit area page 8.5

Paper Jam 2 In the fuser area or 
around the toner 
cartridge

page 8.7

Bypass Jam In the Bypass tray page 8.8
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3 Remove the jammed paper by gently pulling it straight out.

If there is any resistance and the paper does not move 
when you pull or if you cannot see the paper in this area, 
skip to the fuser area around the toner cartridge; see 
page 8.7. 

4 Insert the paper tray into the machine until it snaps into 
place.

5 Open and close the front cover to resume printing.

In the Paper Exit Area

1 Open and close the front cover. The jammed paper 
automatically exits the machine.

If the paper does not exit, continue to Step 2.
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2 Gently pull the paper out of the front output tray. Skip to 
Step 6. 

3 If there is any resistance and the paper does not move 
when you pull or if you cannot see the paper in the front 
output tray, open the rear cover.

4 Remove the jammed paper by gently pulling it straight out.
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5 Close the rear cover.

6 Open and close the front cover to resume printing.

In the Fuser Area or Around the Toner 
Cartridge

NOTE: The fuser area is hot. Take care when removing paper 
from the machine.

1 Open the front cover and pull the toner cartridge out, lightly 
pushing it down.

2 Remove the jammed paper by gently pulling it straight out.
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3 Replace the toner cartridge and close the front cover. 
Printing automatically resumes.

In the Bypass Tray

“Bypass Jam” appears on the display when you try to print using 
the Bypass tray and when the machine does not detect paper 
due to no paper or improper paper loading.

“Bypass Jam” also may occur when the paper is not properly fed 
into the machine through the Bypass tray. In that case, pull the 
paper out of the machine.
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Tips for Avoiding Paper Jams

By selecting the correct paper types, most paper jams can be 
avoided. If a paper jam occurs, follow the steps outlined in 
“Clearing Paper Jams” on page 8.4. 

• Follow the procedures in “Loading Paper” on page 1.12. Ensure 
that the adjustable guides are positioned correctly.

• Do not overload the paper tray. Ensure that the paper is below 
the paper capacity mark on the inside wall of the paper tray.

• Do not remove the paper from the tray while your machine is 
printing.

• Flex, fan and straighten the paper before loading. 

• Do not use creased, damp or highly curled paper.

• Do not mix paper types in the paper tray.

• Use only recommended print materials. See “Paper 
Specifications” on page B.6.

• Ensure that the recommended print side of print materials is 
facing down in the paper tray and facing up in the Bypass tray.
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Clearing LCD Error Messages

Display Meaning Suggested solutions

Bypass Jam

Your machine detects non 
feeding from the Bypass 
tray.

Load paper in the Bypass tray. Or 
remove the jammed paper from the 
Bypass tray.

Cancel ?

1:Yes  2:No

Your machine’s memory is 
full during the machine 
stores the document into 
the memory.

To cancel the fax job, press the 1 
button to accept “Yes.” 
If you want to send the pages were 
stored, press the 2 button to accept 
“No.” You should send the 
remaining pages later when the 
memory is available.

Comm. Error

(only for SCX-4216F)
The machine has a 
communication problem.

Ask the sender to try again.

Document Jam

(only for SCX-4116/
4216F)

The loaded document has 
jammed in the ADF 
(Automatic Document 
Feeder).

Clear the document jam. See 
page 8.2.

Door Open
The front or rear cover is 
not securely latched.

Close the cover until it locks in 
place.

CRU Fuser Error

There is a problem in the 
fuser unit.

Unplug the power cord and plug it 
back in. If the problem persists, 
please call for service.

Heating Error

Open Heat Error

Over Heat

Group Not 

Available

(only for SCX-4216F)

You have tried to select a 
group location number 
where only a single 
location number can be 
used, such as when 
adding locations for a 
broadcasting operation.

Just use a speed dial number or dial 
a number manually using the 
number keypad.
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Incompatible

(only for SCX-4216F)

The remote machine did 
not have the requested 
feature, such as a delayed 
transmission.

It also occurs if the 
remote machine does not 
have enough memory 
space to complete the 
operation you are 
attempting.

Reconfirm the remote machine’s 
features.

Invalid 

Cartridge

You have used 
unauthorized cartridge.

You must use a Samsung approved 
cartridge.

Line Busy

(only for SCX-4216F)

The remote party did not 
answer or the line is 
already engaged.

Try again after a few minutes.

Line Error

(only for SCX-4216F)

Your machine cannot 
connect with the remote 
machine or has lost 
contact because of a 
problem with the phone 
line.

Try again. If the problem persists, 
wait an hour or so for the line to 
clear and try again.

Or, turn the ECM mode on. See the 
Facsimile User’s Guide.

Load Document

You have attempted to set 
up a copy or fax operation 
with no document loaded.

Load a document and try again.

LSU Error

A problem has occurred in 
the LSU (Laser Scanning 
Unit).

Unplug the power cord and plug it 
back in. If the problem persists, 
please call for service.

Memory Full

(only for SCX-4216F)

The memory is full. Delete unnecessary documents, 
retransmit after more memory 
becomes available or split the 
transmission into more than one 
operation.

No Answer

(only for SCX-4216F)

The remote fax machine 
has not answered after 
several redial attempts.

Try again. Make sure that the 
remote machine is operational.

No Cartridge
The toner cartridge is not 
installed.

Install the toner cartridge. See 
page 1.10.

No. Not 

Assigned

(only for SCX-4216F)

The speed dial location 
you tried to use has no 
number assigned to it.

Dial the number manually using the 
number keypad or assign the 
number. See the Facsimile User’s 
Guide.

Display Meaning Suggested solutions
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No Paper
The paper in the paper 
tray has run out.

Load paper in the paper tray. See 
page 1.12.

Operation Not 

Assigned

(only for SCX-4216F)

You are doing in the Add/
Cancel operation, but 
there is no jobs waiting.

Check the display to see if there is 
any scheduled job. The display 
should indicate them in the standby 
mode, for example, Delay Fax.

Paper Jam 0

Paper has jammed in the 
feeding area of the paper 
tray.

Clear the jam. See page 8.4.

Paper Jam 1
Paper has jammed in the 
paper exit area.

Clear the jam. See page 8.5.

Paper Jam 2
Paper has jammed in the 
fuser area.

Clear the jam. See page 8.7.

Power Failure

Power has turned off then 
on and the machine’s 
memory has not been 
saved.

You need to start again the job 
which you were trying to do before 
the power failure.

Retry Redial?

(only for SCX-4216F)

The machine is waiting for 
a specified time interval to 
redial a previously busy 
station.

You can press Enter to immediately 
redial, or Stop/Clear to cancel the 
redial operation.

Stop Pressed

The Stop/Clear button is 
pressed during a copy or 
fax operation.

Try again.

Toner Empty

The toner cartridge has 
run out. The machine 
stops.

Replace with a new toner cartridge. 
See page 7.7.

Toner Low The toner is almost empty.

Take out the toner cartridge and 
gently shake it. By doing this, you 
can temporarily reestablish printing 
operations.

Display Meaning Suggested solutions
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Solving Problems

The following chart lists some conditions that may occur and the 
recommended solutions. Follow the suggested solutions until 
the problem is corrected. If the problem persists, please call for 
service.

Paper Feeding Problems

Condition Suggested solutions

Paper is jammed during 
printing.

Clear the paper jam. See page 8.4.

Paper sticks together. • Ensure that there is not too much paper in the paper tray. 
The paper tray can hold up to 250 sheets of paper, 
depending on the thickness of your paper.

• Make sure that you are using the correct type of paper. See 
“Paper Specifications” on page B.6.

• Remove paper from the paper tray and flex or fan the paper.
• Humid conditions may cause some paper to stick together.

Multiple sheets of paper 
do not feed.

• Different types of paper may be stacked in the paper tray. 
Load the paper of only one type, size and weight.

• If multiple sheets have caused a paper jam, clear the paper 
jam. See page 8.4.

Paper does not feed into 
the machine.

• Remove any obstructions inside the machine.
• Paper has not been loaded correctly. Remove paper from the 

tray and reload it correctly.
• There is too much paper in the paper tray. Remove excess 

paper from the tray.
• The paper is too thick. Use only paper that meets the 

specifications required by the machine. See “Paper 
Specifications” on page B.6.

The paper keeps 
jamming.

• There is too much paper in the paper tray. Remove excess 
paper from the tray. If you are printing on special materials, 
use the Bypass tray.

• An incorrect type of paper is being used. Use only paper that 
meets the specifications required by the machine. See 
“Paper Specifications” on page B.6.

• There may be debris inside the machine. Open the front 
cover and remove the debris.

Transparencies stick 
together in the paper 
exit.

Use only the transparencies specifically designed for a laser 
printer. Remove each transparency as it exits from the 
machine.
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Printing Problems

Envelopes skew or fail 
to feed correctly.

Ensure that the paper guide is against both sides of the 
envelopes.

Condition Suggested solutions

Condition Possible cause Suggested solutions

The machine 
does not print.

The machine is not 
receiving power.

Check the power cord connections. Check 
the power switch and the power source.

The machine is not 
selected as the default 
printer.

Select Samsung SCX-4x16 Series as your 
default printer in your Windows.

Check the machine for 
the following:

• The front or rear cover is not closed.
• Paper is jammed.
• No paper is loaded.
• The toner cartridge is not installed.

If a printer system error occurs, contact 
your service representative.

The connection cable 
between the computer 
and the machine is not 
connected properly.

Disconnect the printer cable and reconnect 
it.

The connection cable 
between the computer 
and the machine is 
defective.

If possible, attach the cable to another 
computer that is working properly and print 
a job. You can also try using a different 
printer cable.

The port setting is 
incorrect.

Check the Windows printer setting to make 
sure that the print job is sent to the correct 
port, for example, LPT1. If the computer 
has more than one port, make sure that the 
machine is attached to the correct one.

The machine may be 
configured incorrectly. 

Check the printer properties to ensure that 
all of the print settings are correct. 

The printer driver may 
be incorrectly installed.

Remove the printer driver and then reinstall 
it; see page 2.9 and page 2.4 respectively. 

The machine is 
malfunctioning.

Check the display message on the control 
panel to see if the machine is indicating a 
system error.
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The machine 
selects print 
materials from 
the wrong 
paper source.

The paper source 
selection in the printer 
properties may be 
incorrect.

For many software applications, the paper 
source selection is found under the Paper 
tab within the printer properties. Select the 
correct paper source. See page 5.8.

Print job is 
extremely slow.

The job may be very 
complex.

Reduce the complexity of the page or try 
adjusting the print quality settings.

The maximum print speed of your machine 
is 17 PPM for Letter-sized paper.

If you are using 
Windows 9x/Me, the 
Spooling Setting may 
be set incorrectly. 

From the Start menu, choose Settings and 
Printers. Right-click the Samsung 
SCX-4x16 Series printer icon, choose 
Properties, click the Details tab, and then 
choose the Spool Settings button. Select 
the desired spool setting.

Half the page is 
blank.

The page orientation 
setting may be 
incorrect.

Change the page orientation in your 
application. See page 5.3.

The paper size and the 
paper size settings do 
not match.

Ensure that the paper size in the printer 
driver settings matches the paper in the 
tray.

The machine 
prints, but the 
text is wrong, 
garbled, or 
incomplete.

The printer cable is 
loose or defective.

Disconnect the printer cable and reconnect. 
Try a print job that you have already printed 
successfully. If possible, attach the cable 
and the machine to another computer and 
try a print job that you know works. Finally, 
try a new printer cable.

The wrong printer 
driver was selected.

Check the application’s printer selection 
menu to ensure that your machine is 
selected.

The software 
application is 
malfunctioning.

Try printing a job from another application.

The operating system is 
malfunctioning.

Exit Windows and reboot the computer. 
Turn the machine off and then back on 
again.

Condition Possible cause Suggested solutions
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Pages print, but 
are blank.

The toner cartridge is 
defective or out of 
toner.

Redistribute the toner. if necessary. See 
page 7.6.

If necessary, replace the toner cartridge.

The file may have blank 
pages.

Check the file to ensure that it does not 
contain blank pages.

Pages print, but 
are blank.
(continued)

Some parts, such as 
the controller or the 
board, may be 
defective.

Contact a service representative.

The illustrations 
print incorrectly 
in Adobe 
Illustrator.

The setting in the 
software application is 
wrong.

Print the document with selecting 
Download as Bit Image in the Advanced 
Options window of the Graphic properties.

An error occurs 
repeatedly 
when you are 
printing with 
the USB 
connection.

When the USB mode is 
set to “Fast,” some PC 
users may experience 
poor USB 
communication.

Change the USB mode to “Slow.” To do so, 
follow these steps:

1. Press Menu on the control panel until 
“Machine Setup” appears on the top line 
of the display.

2. Press the scroll button (� or �) until 
“USB Mode” appears on the bottom line, 
and press Enter.

3. Press the scroll button (� or �) to select 
“Slow.”

4. Press Enter to save the selection.

5. Press Stop/Clear to return to the 
standby mode. 

Condition Possible cause Suggested solutions
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Printing Quality Problems

The dirty inside of the machine or improper paper loading may reduce the print 
quality. See the table below to troubleshoot the problem. 

Condition Suggested solutions

Light or faded 
print

If a vertical white streak or faded area appears on the page:
• The toner supply is low. You may be able to temporarily 

extend the toner cartridge life. See “Redistributing Toner” on 
page 7.6. If this does not improve the print quality, install a 
new toner cartridge.

• The paper may not meet paper specifications; for example, 
the paper is too moist or too rough. See “Paper 
Specifications” on page B.6.

• If the entire page is light, the print resolution setting is too 
low or Toner Save mode is on. Adjust the print resolution and 
turn the Toner Save mode off. See page 5.20 and page 1.19 
respectively.

• A combination of faded or smeared defects may indicate that 
the toner cartridge needs cleaning. See “Cleaning the Drum” 
on page 7.9.

Toner specs • The paper may not meet specifications; for example, the 
paper is too moist or too rough. See “Paper Specifications” on 
page B.6.

• The transfer roller may be dirty. Clean the inside of your 
machine. See page 7.3.

• The paper path may need cleaning. See “Cleaning the Drum” 
on page 7.9.

Dropouts If faded areas, generally rounded, occur randomly on the page:
• A single sheet of paper may be defective. Try reprinting the 

job.
• The moisture content of the paper is uneven or the paper has 

moist spots on its surface. Try a different brand of paper. See 
“Paper Specifications” on page B.6.

• The paper lot is bad. The manufacturing processes can cause 
some areas to reject toner. Try a different kind or brand of 
paper.

• The toner cartridge may be defective. See “Vertical repetitive 
defects” on the next page.

•  If these steps do not correct the problems, contact a service 
representative.

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc
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Vertical lines If black vertical streaks appear on the page:
• The drum inside the toner cartridge has probably been 

scratched. Install a new toner cartridge. See “Installing the 
Toner Cartridge” on page 1.10.

Gray background If the amount of background shading becomes unacceptable:
• Change to a lighter weight pages. See “Paper Specifications” 

on page B.6.
• Check the machine’s environment; very dry (low humidity) or 

high humidity (higher than 80% RH) conditions can increase 
the amount of background shading.

• Remove the old toner cartridge and install a new one. See 
“Installing the Toner Cartridge” on page 1.10.

Toner smear • Clean the inside of the machine. See page 7.3.
• Check the paper type and quality. See “Paper Specifications” 

on page B.6.
• Remove the toner cartridge and install a new one. See 

“Installing the Toner Cartridge” on page 1.10.

Vertical repetitive 
defects

If marks repeatedly appear on the printed side of the page at 
even intervals:
• The toner cartridge may be damaged. If a repetitive mark 

occurs on the page, print a cleaning sheet several times to 
clean the cartridge; see “Cleaning the Drum” on page 7.9. 
After the printout, if you still have the same problems, install 
a new toner cartridge. See “Installing the Toner Cartridge” on 
page 1.10.

• Parts of the machine may have toner on them. If the defects 
occur on the back of the page, the problem will likely correct 
itself after a few more pages.

• The fusing assembly may be damaged. Contact a service 
representative.

Condition Suggested solutions

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc
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Background 
scatter

Background scatter results from bits of toner distributed on the 
printed page. 
• The paper may be too damp. Try printing with a different 

batch of paper. Do not open packages of paper until 
necessary so that the paper does not absorb too much 
moisture.

• If background scatter occurs on an envelope, change the 
printing layout to avoid printing over areas that have 
overlapping seams on the reverse side. Printing on seams can 
cause problems.

• If background scatter covers the entire surface area of a 
printed page, adjust the print resolution through your 
software application or the printer properties.

Misformed 
characters

• If characters are improperly formed and producing hollow 
images, the paper stock may be too slick. Try a different 
paper. See “Paper Specifications” on page B.6.

• If characters are improperly formed and producing a wavy 
effect, the scanner unit may need service. For service, 
contact a service representative.

Page skew • Ensure that the paper is loaded properly.
• Check the paper type and quality. See “Paper Specifications” 

on page B.6.
• Ensure that the paper or other material is loaded correctly 

and the guides are not too tight or too loose against the 
paper stack.

Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high temperature and 

humidity can cause paper curl. See “Paper Specifications” on 
page B.6.

• Turn over the stack of paper in the paper tray. Also try 
rotating the paper 180° in the tray.

Condition Suggested solutions

A

AaBbCcAaBbCcAaBbCcAaBbCcAaBbCc
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Wrinkles or 
creases

• Ensure that the paper is loaded properly.
• Check the paper type and quality. See “Paper Specifications” 

on page B.6.
• Turn over the stack of paper in the paper tray. Also try 

rotating the paper 180° in the tray.

Back of printouts 
are dirty

Check for leaking toner. Clean the inside of the machine. See 
page 7.3.

Black pages • The toner cartridge may not be installed properly. Remove 
the cartridge and reinsert.

• The toner cartridge may be defective and need replacing. 
Install a new toner cartridge. See “Installing the Toner 
Cartridge” on page 1.10.

• The machine may require repair. Contact a service 
representative.

Loose toner • Clean the inside of the machine. See page 7.3.
• Check the paper type and quality. See “Paper Specifications” 

on page B.6.
• Install a new toner cartridge. See “Installing the Toner 

Cartridge” on page 1.10.
• If the problem persists, the machine may require repair. 

Contact a service representative.

Character Voids Character voids are white areas within the parts of characters 
that should be solid black:
• If you are using transparencies, try another type of 

transparency. Because of the composition of the 
transparency, some character voids are normal. 

• You may be printing on the wrong surface on the paper. 
Remove the paper and turn it around. 

• The paper may not meet paper specifications. See “Paper 
Specifications” on page B.6.

Condition Suggested solutions

A

A
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Fax Problems (For SCX-4216F)

Horizontal stripes If horizontally aligned black streaks or smears appear:
• The toner cartridge may be installed improperly. Remove the 

cartridge and reinsert.
• The toner cartridge may be defective. Install a new toner 

cartridge. See “Installing the Toner Cartridge” on page 1.10.
• If the problem persists, the machine may require repair. 

Contact a service representative.

Condition Suggested solutions

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc

Condition Suggested solutions

The machine is not 
working, there is no 
display and the buttons 
are not working.

• Unplug the power cord and plug it in again. 
• Ensure that there is power to the electrical receptacle.

No dial tone sounds.
• Check that the phone line is connected properly.
• Check that the phone socket in the wall is working by 

plugging in another phone.

The numbers stored in the 
memory do not dial 
correctly.

Make sure that the numbers are stored in the memory 
correctly. Print a Phonebook list, referring to the Facsimile 
User’s Guide.

The document does not 
feed into the machine.

• Make sure that the document is not wrinkled and you are 
putting it in correctly. Check that the document is the 
right size, not too thick or thin. 

• Make sure that the ADF (Automatic Document Feeder) 
cover is firmly closed.

Faxes are not received 
automatically.

• The FAX mode should be selected. 
• Make sure that there is paper in the tray.
• Check to see if the display shows “Memory Full.”

The machine does not 
send.

• Make sure that the document is loaded in the ADF or on 
the document glass. 

• “TX” should show up on the display. 
• Check the other fax machine you are sending to, to see if 

it can receive your fax.
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The incoming fax has 
blank spaces or is received 
with a poor-quality.

• The fax machine sending you the fax may be faulty. 
• A noisy phone line can cause line errors. 
• Check your machine by making a copy. 
• The toner cartridge may be empty. Replace the toner 

cartridge, referring to page 7.7. 

Some of the words on a 
incoming fax are 
stretched.

The fax machine sending you the fax had a temporary 
document jam. 

There are lines on the 
documents you send.

Check your scan glass for marks and clean it. See 
page 7.4.

The machine dials a 
number, but a connection 
with another fax machine 
fails.

The other fax machine may be turned off, out of paper, or 
cannot answer incoming calls. Speak with the other 
machine operator and ask her/him to sort out the problem.

Documents are not stored 
in the memory. 

There may not be enough memory to store the document. 
If the display shows a “Memory Full” message, delete any 
documents you no longer need from the memory and then 
restore the document.

Blank areas appear at the 
bottom of each page or on 
other pages, with a small 
strip of text at the top.

You may have chosen the wrong paper settings in the user 
option setting. See page 1.18 for the paper tray and 
page 3.10 for the Bypass tray.

Condition Suggested solutions
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Copying Problems

Condition Suggested solutions

Copies are too light or too 
dark.

• If the original is light, use the Contrast button to 
darken the background of the copies.

• If the original is dark, use the Contrast button to 
lighten the background of the copies.

Smears, lines, marks or spots 
appears on copies.

• If defects are on the original, press the Contrast 
button to lighten the background of your copies.

• If no defects are on the original, clean the document 
glass and underside of the document cover. See 
page 7.4.

Copy image is skewed.
• Ensure that the original is positioned correctly on 

document glass.
• Check that the copy paper is loaded correctly.

Blank copies print out.
Ensure that the original is face down on the document 
glass or face up in the Automatic Document Feeder (for 
SCX-4116/4216F only).

Image rubs off the copy 
easily.

• Replace the paper in the paper tray with paper from a 
new package.

• In high humidity areas, do not leave paper in the 
machine for the extended periods of time.

Frequent copy paper jams 
occurs.

• Fan the stack of paper, then turn it over in the paper 
tray. Replace the paper in the tray with a fresh supply. 
Check/adjust the paper guides, if necessary.

• Ensure that the paper is the proper paper weight. 75 
g/m2 (20 lb) bond paper is recommended.

• Check for copy paper or pieces of copy paper 
remaining in the machine after a paper jam has been 
cleared.

Fewer copies from the toner 
cartridge than expected prints 
out.

• Your originals may contain pictures, solids or heavy 
lines. For example, your originals may be forms, 
newsletters, books or other documents that use more 
toner. 

• The machine may be turned frequently on and off. 
• The document cover may be left open while copies are 

being made.
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Scanning Problems

Condition Suggested solutions

The scanner does not 
work.

• Make sure that you place the document to be scanned face 
down on the document glass, or face up in the Automatic 
Document Feeder (for SCX-4116/4216F).

• There may not be enough available memory to hold the 
document you want to scan. Try the Prescan function to see 
if that works. Try lowering the scan resolution rate.

• Check that the USB or parallel cable is connected properly.
• Make sure that the USB or parallel cable is not defective. 

Switch the cable with a known good cable. If necessary, 
replace the cable.

• If you are using a parallel cable, ensure that it is compliant 
with the IEEE 1284 standard.

• Check that the scanner is configured correctly. Check scan 
setting in the SmarThru Configuration or the application you 
want to use to make certain that the scanner job is being 
sent to the correct port, for example, LPT1.

The unit scans very 
slowly.

• Check if the machine is printing received data. Scan the 
document after the current job is completed.

• Graphics are scanned more slowly than text.
• Communication speed becomes slow in scan mode because 

of the large amount of memory required to analyze and 
reproduce the scanned image. Set your computer to ECP 
printer mode through BIOS setting. It will help to increase 
the speed. For details on how to set BIOS, refer to your 
computer User’s Guide.

Message appears on 
your computer screen: 
“Scanner is busy 
receiving or printing 
data. When the current 
job is completed, try 
again.”

There may be a copying or printing job in progress. When the 
current job is complete, try the job again.
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Common Macintosh Problems

Problem Possible Cause and Solution

The printer driver icon 
does not appear in 
Chooser.

Software is not installed correctly. Reinstall the software; see 
page A.2.

The printer name does 
not appear in the 
Connect to box in 
the Chooser.

• Make sure that the cables are connected correctly and the 
printer is turned on. 

• Check if “Ready” appears on the display of the control panel. 
If not, clear the problem depending on the error message; 
see page 8.10.

• Make sure that the correct printer driver has been selected in 
Chooser.

You cannot use the 
computer while the 
printer is printing.

Background Printing has not been selected.
• Select Background in the Background Printing tab of the 

Samsung SPL II Printer window.
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A
PRINTING FROM A 
MACINTOSH

This chapter includes:

• Installing Software for Macintosh

• Printing a Document

• Using Advanced Printing Features
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Installing Software for Macintosh

Your machine supports Macintosh systems with a built-in USB 
interface. When you print a file from a Macintosh computer, you 
can use the SPL driver to support your machine’s major printing 
features. 

System Requirements

To use your machine and its software with a Macintosh, your 
system should have:

Macintosh Hardware Requirement:

• One of the following Macintosh models:
- Power Macintosh series
- Power Macintosh G3, G4
- iMac series
- PowerBook series
- iBook series

• USB interface 

Macintosh System Requirement:

System 8.6 or later

Installing Software

1 Connecting the machine to the USB port of the computer 
requires a certified USB cable. You will need to buy a USB 
1.1 compliant cable that is within 3 m in length. Connect it 
to the USB connector on your machine.

➜ To the USB port on
    your computer
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NOTE: If you are using a USB hub, connect the machine’s cable to 
the first tier of the hub, or the machine may malfunction. If the 
machine doesn’t work with the hub, connect it directly to the USB 
port. 

2 Turn on your computer and machine.

3 Insert the CD-ROM which came with your machine into the 
CD-ROM drive.

4 Double-click SCX-4x16 on your Macintosh desktop.

5 Double-click the West folder.

6 Double-click the Samsung Laser Printer Installer icon 
next to each language to select the correct one. 

7 Click Continue, and then click Continue.

8 The Samsung Laser Printer Installer window opens. Select 
the installation type. 

The window provides the following two options for software 
installation:

•Easy Install (recommended method): This option installs 
the SPL driver. 

•Custom Install : This option allows you to choose which 
components will be installed, the SPL driver or the Adobe 
Acrobat Reader program for opening the User’s Guide.

9 Click Install.

If other programs are operating, the alert message 
appears. Click Continue to install the software or click 
Cancel, close other programs and install the software.

10After the installation is finished, click Restart.



PRINTING FROM A MACINTOSHA.4

Choosing Your Printer

1 From the Apple menu, select Chooser.

2 From the left pane of the Chooser window, click SAMSUNG 
SPL II. Then your printer name will appear in the right 
pane of the Chooser window.

3 Click SAMSUNG SPL II and close the Chooser window.

4 The message window indicating that you have changed your 
current printer appears. Click OK. 

5 An SAMSUNG SPL II printer icon will be created on your 
desktop.

Printing a Document

When you print with a Macintosh computer, you need to check 
the printer software setting in each application you use. Follow 
these steps to print from a Macintosh:

1 Open a Macintosh application and select a file you want to 
print.

2 Open the File menu, and click Page Setup (Document 
Setup in some applications). 

3 Choose your paper size, orientation, paper type and other 
options and click OK.
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Choose Watermark to add a watermark to each page in 
your document to emphasize its purpose or indicate how it 
should be handled. For details on the watermark options, 
see page 5.13.

4 Open the File menu and click Print. You will see the 
SAMSUNG SPL II Printer window.

5 Choose the number of copies and indicate which pages you 
want to print. 

6 Click Print when you finish setting the options.

For advanced printing 
features, select the 
desired option. For 
details, see page A.6.

Restores the default 
settings.

Saves the current 
settings for later use.




